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Lightroom & ACR Profiles

The new Profiles feature was added to Lightroom and ACR (Adobe Camera Raw) 
in April of 2018 and in this lesson, we’re going to learn about what they do and 
how to use them. The Profiles feature is not a new concept, but in this version, 
Adobe has greatly extended their functionality to expand what Lightroom or ACR 
is capable of doing.

Profiles (Prior to April 2018 update)

• Every image you’ve ever opened in Lightroom or ACR has had a profile speci-
fied. You could find this Profile setting within the Camera Calibration panel. 

• Adobe Standard was the previous default profile for raw files. It makes images 
from multiple camera brands look similar.

• Camera Matching profiles simulate in-camera jpeg processing. (The choices are 
unique to each camera maker.)

• Jpeg files are pre-processed in camera and therefore come with an embedded 
profile. 

New Adobe Profiles

• In the April 2018 update, the Profiles feature was moved from the Camera Cal-
ibration panel to the top of the Basic panel. 

• All profiles start with Adobe Standard, then tweak color/contrast for unique 
needs.

• The new default is Adobe Color, which adds saturation and contrast while pro-
tecting skin tones.

• Adobe Vivid is a bolder variation of Adobe Color.
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• Adobe Neutral is a mellowed variation of Adobe Color.

• Adobe Portrait is optimized for skin tones.

• Adobe Landscape has no skin protection and makes skies and foliage more 
vivid.

Define your default profile

• Choose which Adobe profile best matches your most common shooting style.

• Reset all settings to their defaults, choose your profile, then set current settings 
as the default.

• Create presets for other profiles that are appropriate to your work. 

• Apply preset on import, or immediately after import.

• Ignore for jpeg files, but you can use creative profiles later in the processing 
phase. 

The Profile Browser As we mentioned above, 
the Profile settings can now be found at the 
top of the Basic panel. (In Lightroom, this will 
be located on the right side of the Develop 
Module.) Click on the little icon that looks like 
four rectangles, to the right of the profile menu, 
and the Profile Browser will expand. Here, you 
will find several different expandable catego-
ries of profiles. The Adobe Raw profiles are a 
good starting point if you are working with 
a raw file. Hover your cursor over the differ-
ent profiles and you will get a preview of what 
your image would look like with that profile 
applied. 

Click on the highlighted icon to access 
the Profile Browser. 
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Setting a profile as the default: Lightroom 
If you know that you always want a specific 
profile applied, you can set that profile as 
the default. In order to do this, you will first 
need to make sure that every develop set-
ting is at its default setting. Return all slid-
ers to their default settings by clicking the 
Reset button in the bottom right of Light-
room’s interface. Next, open the Profile set-
tings and choose the profile you would like 
to serve as your default. When you’re done, 
click the Close button in the upper right 
corner of the Profile Browser. Now, go to 
the Develop menu (You’ll need to be in the 
Develop Module for this to be available) and 
choose Set Default Settings. A dialog box 

The Profile Browser is open on the right side of the interface. When we hover our cursor 
over the different profiles, we see a preview of the effects in the main image window.

Click the Reset button to return all the 
sliders to their default settings.

This Develop menu is available while in 
the Develop Module.
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will appear, asking you to confirm that you want to update the default settings. 
Click the Update to Current Settings button. Now, every time you open a raw file 
that has not been worked on before, it will have your chosen profile applied right 
from the beginning. 

Setting a profile as the default: Camera Raw In Camera Raw, return all the sliders 
to their default settings by clicking on the little menu in the top right corner of 
the adjustments panel and choos-
ing Camera Raw Defaults from the 
menu that appears. Then, choose 
the profile that you would like to 
use as the default. (The Profile set-
tings are located at the top of the 
Basic panel, just like in Lightroom.) 
Lastly, go back to the menu in the 
top right corner of the adjustments 
panel and choose Save New Cam-
era Raw Defaults. 

Creating profiles in Photoshop

You can create your own profiles, which are simply a series of adjustments that 
you make in Photoshop and save as small profile files. Then you can apply those 
changes in Lightroom and ACR. In creating a profile, you can use any of the ad-
justments that are available as adjustment layers in Photoshop and you can stack 
multiple adjustments in order to create an effect. You can also use Photoshop’s 
blending modes and blending sliders with these adjustment layers. You can NOT 
use location-specific adjustments (layer masks, vignettes, etc.). These profiles al-
low us to get beyond the limitations of all the adjustment sliders that can be found 
in Lightroom or ACR. 

In ACR, click on 
the “hamburger 
menu” (circled) 
to access the 
Camera Raw 
Defaults  
settings. 
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To create a profile, your document will need to consist of the image layer and 
then one or more adjustment layers stacked on top of it. Go to the File menu and 
choose Export > Color Lookup Tables. A Color Lookup Table is a way to summa-
rize what one or more adjustments do to a picture without needing to have those 
adjustment capabilities in the program we use it in. In other words, it looks at the 
difference between the original picture and the end result and then summarizes 
that change in a profile file. 

After choosing Color Lookup Tables from the Export menu, a dialog box will ap-
pear, and it will include a Grid Points setting, which controls how accurately it will 
be able to describe the adjustment. We’ll enter 32 here and then select the Cube 
option under the Formats category. We’ll click OK and will then be prompted to 
give the profile a name, choose a location for the file and click the Save button. 

Now there is a step that we need to do in ACR in order to create the profile that 
can be used in either ACR or Lightroom. We’ll open a raw file in ACR and open 
the Presets tab on the right side of the interface. (The icon looks like three adjust-

Left: To create a profile, the Photoshop document will need to have an image layer wuth ad-
justment layers on top of it. Right: In the Export Color Lookup Tables dialog, we set the Grid 
Points slider to 32 and chose CUBE from the format options.
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ment sliders.) We’ll hold down the Option 
key (Alt on Win) and click the New button 
at the bottom of the panel in order to call 
up the New Profile dialog box. We’ll type in 
the profile’s name at the top of the dialog. 
Below that, there is a list of settings that 
may or may not be grayed out, depend-
ing on whether any changes were made 
to the image in ACR. If no changes were 
made, they’ll all be grayed out. If there 
were changes made, this is where we can 
determine if these changes should be in-
cluded in the profile. We’ll make sure the 
Look Table check box is turned off and 
then we’ll turn ON the Color Lookup Ta-
ble check box. When we do this, we’ll be 
prompted to navigate to the file we saved 
(from Photoshop) on our hard drive and 
then click the Load button. We’ll need to 
use the Space menu to specify what color 
space was being used when the profile was 
created. When we go to apply the profile 
later in Lightroom or ACR, there will be a 
slider that determines how strongly the ef-
fect should be applied. The Min setting determines how much of the adjustment 
you’d see when you move this slider down to zero. If this setting is set to zero, then 
you’d see none of the effect whatsoever. In the video example, we’re going to set 
this to 40, which will allow the adjustment to be lowered to 40% of the full effect. 
The Max setting will determine how strongly the effect will be applied when the 
slider is set to 200, which is the highest setting for the slider. In our example, we 
set this to 150%. The Amount setting determines what the default slider setting 
should be, and we’ll leave this at 100%. 

The Presets panel is accessed by click-
ing the icon on the right side of the ACR 
interface (circled, top). Hold down the 
Option key while clicking the New icon 
(circled, bottom) to create a new profile. 
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When choosing a profile 
to use within Lightroom 
or ACR, the menu will be 
divided into categories. 
You can specify which 
category the profile 
should go in by using the 
Set menu near the top of 
the New Profile dialog. 
You can also create a 
new set in which to place 
the profile. After specify-
ing all the settings in the 
New Profile dialog, we’ll 
click the OK button. Now, 
when we open the Profile 
Browser in Lightroom or 
ACR, the new profile will 
be listed under the set/
category we chose when 
creating the profile. 

The Camera Raw settings for creating a new profile
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Making changes to a profile 

After you create a profile, you can make changes to it and specify its sorting order, 
but you must do so from within ACR. If you open the Profile Browser and right-
click on a profile, a menu will pop up, giving you the option to Rename Profile. If 
you choose this, a dialog will appear, allowing you to change four things (including 
the name). There is a way to access many more options. Hold down the Option 
key (Alt on Win) while double-clicking on a profile and a different dialog will ap-
pear that gives you lots more options.

One of the options 
available in this di-
alog is the Short 
Name, and this is the 
name that would be 
used when working 
with Lightroom on 
your phone.  The Sort 
Name is not a name 
that will be displayed. 
It’s a name that is 
used to determine 
what order the pro-
file should appear in. 
The profiles are listed 
alphabetically based 
on the profile name 
UNLESS you type 
something in this 
field. This means that 
you can type num-
bers into this field for 

If you hold down the Option key (Alt on Win) while clicking the 
Rename Profile menu item, you’ll get this expanded set of options.
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each of your profiles to specify what order they should appear in within the Pro-
file Browser. At the bottom of the expanded Rename dialog, there is a “Support 
Amount Slider” check box. If you turn this off, then the chosen profile will not have 
an Amount slider to go along with it. 

The Applicability settings can be used to determine when the chosen profile will 
be available. The Model menu lets you specify whether you’d like the profile to be 
available only on images shot with a certain camera or shot with a certain profile. 
The Type menu allows you to specify what file types the profile can be used on. 
Use the Mode menu to determine whether the profile will be available on color 
images, monochrome images or both. The Range menu determines whether the 
profile will be available on HDR images. 

More profile options

We mentioned earlier that you can create a new profile from within the Presets 
panel in ACR. Let’s look at some additional options when doing so. We’ll hold 
down the Option key and click on the New icon at the bottom of the Presets panel. 
This will bring up the New Profile dialog. 

In creating a profile, we can use any combination of adjustment layers within Pho-
toshop. But what if we want to include an adjustment that is not included in Pho-
toshop? For example, the Highlights, Shadows and Clarity sliders are only available 
in Lightroom & ACR but not Photoshop. Here’s how to include these adjustments. 
Create the profile in Photoshop using the desired adjustment layers. Then open 
the same image you used to create the profile in ACR. Adjust the sliders as you 
see fit. Then, open the Presets panel, hold down the Option key (Alt on Win) and 
click on the New icon at the bottom of the panel. This will bring up the New Profile 
dialog box. We mentioned early that the list of adjustments will be grayed out if no 
adjustments have been applied. Since you moved the sliders this time, the check 
boxes will be available. This allows you to include settings made within ACR to the 
new profile. Note that you can also use the Post-Crop Vignette slider within ACR 
and have it included in the profile as well. 
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Within the New Profile dia-
log, there is also a Tone Map 
Strength setting and this is 
useful for HDR images. It deter-
mines how sensitive the high-
lights and shadows sliders will 
be when you adjust them. If you 
do a lot of HDR and find that 
you max out the Shadows and/
or Highlights sliders on a regu-
lar basis, then change this menu 
to Medium or High. 

The Look Table settings with-
in the New Profile dialog are 
useful if you want your profile 
to start with one of the Ado-
be Raw profiles as a base. You 
would make sure the image 
you’re working with is using 
that profile and then you would 
turn on the Look Table check 
box within the New Profile di-
alog and then select the profile 
from the Table menu. Note that 
the Look Table options will only 
be available when working with 
raw files. 

In the New Profile dialog, turn on any check boxes for 
adjustments made within Camera Raw that you would 
like to be included in the profile. 


